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1. Science of Science Research 15t Week

Information Visualization
3. CIShell Powered Tools: Network Workbench and Science of Science Tool

Temporal Analysis—Burst Detection 271 Week
Geospatial Analysis and Mapping
Topical Analysis & Mapping

34 Week
Tree Analysis and Visualization
Network Analysis
Large Network Analysis

4" Week

10. Using the Scholarly Database at IU
11. VIVO National Researcher Networking

12.  Future Developments
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g . "?: 12 Tutorials in 12 Days at NIH—Overview
[#03] CIShell Powered Tools: Networtk Workbench and Science of Science Tool
»  Using a Million Minds to Build Custom Tools
»  Open Service Gateway Initiative (OSGi)
»  Cyberinfrastructure Shell (CIShell)
»  Network Workbench (NWB) Tool
»  Science of Science (Sci2) Tool
»  Adding Plugins to CIShell Powered Tools
»  Promising Research Ditrections

Recommended Reading

»  Herr, Bruce W., Huang, Weixia, Penumarthy, Shashikant, Borner, Katy . (2007) Designing
Highly Flexible and Usable Cyberinfrastructures for Convergence. In William S. Bainbridge and
Mihail C. Roco (Eds.) Progress in Convergence — Technologies for Human Wellbeing. Annals of the New
York Academy of Sciences, Boston, MA, volume 1093, pp. 161-179. http://cishell.org/papers/06-
cishell.pdf

»  Cyberinfrastructure Shell home page, http://cishell.org.

»  Network Workbench (NWB) Tool home page, http://nwb.slis.indiana.cdu

»  Science of Science (Scii2) Tool home page, http://sci.slis.indiana.cdu/sci2

[#03] CIShell Powered Tools:

Network Workbench and Science of Science Tool
Using a Million Minds to Build Custom Tools




The Changing Scientific Landscape

Star Scientist -> Research Teams: In former times, science was driven by key scientists.
Today, science is driven by effectively collaboratlng co-author teams often comprlsmg
expertise from multiple disciplines and several geospatial locations (Borner, Dall' Asta,
Ke, & Vespignani, 2005; Shneiderman, 2008).

Users -> Contributors: Web 2.0 technologies empower anybody to contribute to
Wikipedia or to exchange images and videos via Fickr and YouTube. WikiSpecies,
WikiProfessionals, or WikiProteins combine wiki and semantic technology in support
of real time community annotation of scientific datasets (Mons et al., 2008).

Cross-disciplinary: The best tools frequently borrow and synergistically combine
methods and techniques from different disciplines of science and empower
interdisciplinary and/or international teams of researchers, practitioners, or educators
to fine-tune and interpret results collectively.

One Specimen -> Data Streams: Microscopes and telescopes were originally used to
study one specimen at a time. Today, many researchers must make sense of massive
streams of multiple types of data with different formats, dynamics, and origin.

Static Instrument -> Evolving Cyberinfrastructure (CI): The importance of hardware
instruments that are rather static and expensive decreases relative to software
infrastructures that are highly flexible and continuously evolving according to the
needs of different sciences. Some of the most successful services and tools are
decentralized increasing scalability and fault tolerance.

Just as the microscope empowered our naked eyes to see cells, microbes, and viruses
thereby advancing the progress of biology and medicine or the telescope opened our
minds to the immensity of the cosmos and has prepared mankind for the conquest of
space, macroscopes promise to help us cope with another infinite: the infinitely complex.
Macroscopes give us a ‘vision of the whole’ and help us ‘synthesize’. They let us detect
patterns, trends, outliers, and access details in the landscape of science. Instead of making
things larger or smaller, macroscopes let us observe what is at once too great, too slow, or
too complex for our eyes.




@ Desirable Features of Macroscopes

Core Architecture & Plugins/Division of Labor: Computer scientists need to design
the standardized, modular, easy to maintain and extend “core architecture”. Dataset
and algorithm plugins, i.e., the “filling”, are provided by those that care and know
most about the data and developed the algorithms: the domain experts.

Ease of Use: As most plugin contributions and usage will come from non-computer
scientists it must be possible to contribute, share, and use new plugins without writing
one line of code. Users need guidance for constructing effective workflows from 100+
continuously changing plugins.

Modularity: The design of software modules with well defined functionality that can be
flexibly combined helps reduce costs, makes it possible to have many contribute, and
increases flexibility in tool development, augmentation, and customization.

Standardization: Adoption of (industry) standards speeds up development as existing
code can be leveraged. It helps pool resources, supports interoperability, but also eases
the migration from research code to production code and hence the transfer of
research results into industry applications and products.

Open Data and Open Code: 1.ets anybody check, improve, or repurpose code and eases
the replication of scientific studies.

Bérner, Katy (in press) Plug-and-Play Macroscopes. Communications of the ACM.

° Example: Science of Science Studies

About 5-20 algorithms are involved in one single study/workflow.
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EXTRACTION ANALYSIS
SIMILARITY [ORDINATION
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Bérner, Katy, Chen, Chaomei, and Boyack, Kevin. (2003) Visualizing Knowledge Domains. ARIST, pp. 179-255.

Domain has about 300 core researchers, 10 key data sources, 20 common tools.

Approaches/algorithms from network science, social science, political science,
economics, physics, information science, webometrics, etc. are highly relevant and new
ones become available every day.




Macroscope Design

Custom Tools for Different Scientific Communities
Information Visualization Cyberinfrastructure

http://iv.slis.indiana.edu
Network Workbench Tool + Community Wiki M

http://nwb.slis.indiana.edu

Science of Science (Sci?) Tool and Portal
http://sci.slis.indiana.edu

Epidemics Cyberinfrastructure
http://epic.slis.indiana.edu

180+ Algorithm Plugins and Branded GUIs
+
Core Architecture

Open Services Gateway Initiative (OSGi) Framework.
http://orgi.or.
Cyberinfrastructure Shell (CIShell)
http://cishell.org

— osci I GINetEl

Computational Scientometrics CI

ﬁ Scholarly Database: 23 million scholarly records
http://sdb.slis.indiana.edu

VIVO Research Networking
{% http:/ /vivoweb.otg

Information Visualization Cyberinfrastructure
http://iv.slis.indiana.edu

Network Workbench Tool + Community Wiki
http://nwb.slis.indiana.edu

2k
4.# Sci2 Tool and Science of Science CI Portal
http:/ /sci.slis.indiana.edu

gfé}:’% Epidemics Cyberinfrastructure
et http://epic.slis.indiana.edu/
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[#03] CIShell Powered Tools:

Network Workbench and Science of Science Tool

Open Service Gateway Initiative (OSGi)
Cyberinfrastructure Shell (CIShell)

bg& C l Cyberinfrastructure Shell (CIShell)
A4 L http://cishell.org

» CIShell is an open soutce software specification for the integration and utilization of
datasets, algorithms, and tools.

» It extends the Open Setvices Gateway Initiative (OSGI) (http://www.osgi.org), a

standardized, component oriented, computing environment for networked services
widely used in industry since 10 years.

» Specifically, CIShell provides “sockets” into which existing and new datasets,
algorithms, and tools can be plugged using a wizard-driven process.

Developers .
6 g - Aid '%
V'8 e, o 1V&],
oV 5 wid

CILShel] Wizards CIShell

o x2 )
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}ggg(: I yne CIShell — Builds on OSGi Industry Standard

CIShell is built upon the Open Services Gateway Initiative (OSGi) Framework.

OSGi (http://www.osgi.org) is
» A standardized, component otiented, computing environment for networked setvices.

Successfully used in the industry from high-end servers to embedded mobile devices
since 8 years.

>
» Alliance members include IBM (Eclipse), Sun, Intel, Oracle, Motorola, NEC and many
>

others.

Widely adopted in open source realm, especially since Eclipse 3.0 that uses OSGi R4
for its plugin model.

Advantages of Using OSGi

» Any CIShell algorithm is a service that can be used in any OSGi-framework based
system.

» Using OSGi, running CIShells/tools can connected via RPC/RMI supporting peet-to-
peer sharing of data, algorithms, and computing power.

Ideally, CIShell becomes a standard for creating OSGi Services for algorithms.
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’ggg(: I yne CIShell — Converter Graph

Y

No central data format.

Y

Sci? Tool has 26 external and internal data formats and 35 converters.

Y

Their relationships can be derived by running ‘File > Converter Graph’ and
plotted as shown here. Note that some conversions are symmetrical (double

arrow) while others are one-directional (arrow).
@file:text/edge

@ file:text/nwb
@file:texttreeml+xml @®dbinsf

@ prefuse data. Tree @file textigraphml+xml
@ file:application/pajeknet
@ prefuse data.Graph @®db:any

@ file:application/pajekmat
® edu.uci.ics.jung.graph.Graph te-applcation’pajekm

® edu berkeley.guir.prefuse.graph.Graph @dbisi Pfiletextipg

@ filetext/xgmml+xml

@java.awtimage Bufferedmage

® file textbibig & 1S XYSEOPUS

®file text/grace @filetext/ps

®file:textiplat ®file:text/isi
@ prefuse.data Table

@fiteitexticsv

@ file:text/nsf

@ file:text/referbib 14




[#03] CIShell Powered Tools:

Network Workbench and Science of Science Tool

Network Workbench (NWB) Tool

Network Workbench Tool

htth nwhb.slis.indiana. NWE Downloads Cummulative

70,000 4 Oct. 2008-Fehb. 2010

0,000

The Network Workbench (NWB) tool
supports researchers, educators, and

50,000

40,000

practitioners interested in the study of
AWerkd

(oG )

f
"
ra
fj
0*4"""'"""""""" '°7;_

biomedical, social and behavioral science,
physics, and other networks.

Dev Zone About

BT Poople Res

# Downloads

30,000

1 Summary
In February 2009, the tool provides more 169 | summary 20000 Jre——
plugins that support the preprocessing, e -
- - - . . scale network analysi =
analysis, modeling, and visualization of (e The envidond 10000 0
maore.
networks. Huovw to cite this proje
More than 50 of these plugins can be NEWEE Updated STEEzEI 3l o
. : : « 5.1.08 Kaelole, 5 EEEEEEE & o
applied or were specifically designed for Kaowiegae, Réa IR - A 1
. (website access .
S&T studies. Time :
= 3.23.08 1.0.0 beta 5 Released Windows (%P & Wista) m DOWNLOAD
= 1.23.09 Ann Mcranie's tutorial abstract for Sunbelt
2008
It has been downloaded more than 65,000 = 11.4.08 Two NWB Pis featured in "Connected—The  Getting Started
K . Power of Six Degrees.” 2008. Anna Maria Talas,  Gog mure documentation
times since December 2006. D o e e Corporation Lid. cetinvorved

Birner, Katy, Huang, Weixia (Bonnie), Linnemeier, Micah, Dubon, Russell |ackson, Phillips, Patrick, Ma, Nianli, Zoss, Angela, Guo,
Hanning & Price, Mark. (2010). Rete-Netzwerk-Red: Analyzing and Visualizing Scholarly Networks Using the Network Workbench Tool.
Scientometrics. V'ol. 83(3), 863-876.
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Project Details

Investigators:

Software Team:

Goal:

Amount:
Duration:
Website:

Katy Bérner, Albert-Laszlo Barabasi, Santiago Schnell,
Alessandro Vespignani & Stanley Wasserman, Er1c Wernert

Lead: Micah Linnemeier
Members: Patrick Phillips, Russell Duhon, Tim Kelley & Ann McCranie

Previous Developers: Weixia (Bonnie) Huang, Bruce Herr, Heng Zhang,
Duygu Balcan, Bryan Hook, Ben Markines, Santo Fortunato, Felix
erhorn Rarnya Sabbmem Vivek S. Thakre & Cesar Hidalg

.._#

Develop a large-scale network analysis, modeling and visualization toolkit
for physics, biomedical, and social science research.

$1,120,926, NSF 11S-0513650 award
Sept. 2005 - Aug. 2009

http://nwb.slis.indiana.edu

Project Details (cont.)

NWB Advisory Board:

James Hendler (Semantic Web) http://www.cs.umd.edu/~hendler

Jason Leigh (CI) http://www.evl.uic.edu/spiff,

Neo Martinez (Biology) http://online.sfsu.edu/~webhead

Michael Macy, Cornell University (Sociology) http://www.soc.cornell.edu/faculty/macy.shtml

Ulrik Brandes (Graph Theory) http://www.inf.uni-konstanz.de/~brandes

Mark Gerstein, Yale University (Bioinformatics) http://bioinfo.mbb.vale.edu
Stephen North (AT&T) http://public.research.att.com/viewPage.cfm?PagelD=81

Tom Snijders, University of Groningen http://stat.gcamma.rug.nl/snijders/

Noshir Contractor, Northwestern University http://www.spcomm.uiuc.edu/nosh




Computational Proteomics

What relationships exist between protein targets of all drugs and all
disease-gene products in the human protein—protein interaction network?

.
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& Genito-urinary
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Figure 2 Drug-target network (DT network). The DT network is generated by using the known associations between FDA-approved drugs and their target
proteins. Circles and rectangles correspond to drugs and target proteins, respectively. A link is placed between a drug node and a target node if the protein

is a known target of that drug. The area of the drug (protein) node is proportional to the number of targets that the drug has (the number of drugs targeting
the protein). Color codes are given in the legend. Drug nodes (circles) are colored according to their Anatomical Therapeutic Chemical Classification, and the
target proteins (rectangular boxes) are colored according to their cellular component obtained from the Gene Ontology database.
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Computational Economics oil “@'

Does the type of product that a fishing A , resetepie e
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Fig. 1. The product space. (A) Hierarchically clustered proximity {¢) matrix  with their proximity value. The sizes of the nodes are proportional to world
representing the 775 SITC-4 product classes exported in the 1998—2000  trade, and their colors are chosen according to the classification introduced by
period. (B) Network representation of the product space. Links are color coded  Leamer. 20




Computational Social Science
Studying large scale social
networks such as Wikipedia

Second Sight: An Emergent Mosaic of
Wikipedian Activity,
The NewScientist, May 19, 2007

& Conference on Network Science
; in Bleomington.

e nvscientil_om

Second sight
image: Brute W, Her and Todd M. Hollowary

Power struggle

How do you keep track of the bubbling
mass of information that is Wikipedia?
This chaotic-leoking mosaic i

attempt ta show which tapics are

pages at the time of writing indude
entries on Sheffield Wednesday football
club, Mikhail Gorbachev and pigs).

The mosaic has been commended in
a competition for images that visualise
netwaork dynamics, coinciding with this
week’s International Workshop and

19 My 2007 Rewciontist| 55

Computational Epidemics

Forecasting (and preventing the effects of) the next pandemic.

Epidenic Modeling in Complex realities, V. Colizza, A. Barrat, M. Barthelenry, A.1V espignani, Comptes Rendus

Biologie, 330, 364-374 (2007).

Reaction-diffusion processes and metapopulation models in heterogeneous networks, V. Colizza, R. Pastor-Satorras,

A.Veespignani, Nature Physics 3, 276-282 (2007).

Modeling the Worldwide Spread
of Pandemic Influenza: Baseline

Case and Containment Interventions,

1. Colizza, A. Barrat, M. Barthelemy,
A.-J. Valleron, A.V espignani,
PhoS-Medicine 4, ¢13, 95-110 (2007).

—eImpact or

Air Travel on Global Spread o Infectious Diseasess—

Mumber {Ro|

o
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NWB Tool 1.0.0

Can be freely downloaded for all
major operating systems from
http://nwb.slis.indiana.edu

Select your operating system from

the pull down menu and download. i
Unpack into a /nwb directory. i
Run /nwb/nwb.exe -
Session log files are stored in i
“Syournwbdirectory*/ logs’ directory. i &

j o Y

Cite as '

NWB Team. (2006). Network : ' e o
Workbench Tool. Indiana University, —
Northeastern University, and University of
Michigan, bttp:/ [ nwb.slis.indiana.edu.

The file was also made available as
mwh-IN-1.0.0.200909181911 NG T-win32.win32.x86.ip

on the computers in the tutorial rooms.

23

File Preprocessing Modeling Analysis Visualization  Scientometrics  Help

Bl console. «——{" console displays data operations w = O || Data Manager =
- 1 L ]
~

|welcome bo the Netwg  (59ve, load, view, etc ] and rreprocessing, modeling, analysis, and
3

| wisualization of small, n ulgor!lhm input parameters,
selection, & acknowledgements as

The MNetwork Workberd  well as error reporting.

supporked in part by the NSF Data Manager keeps track of
115-0513650 award, Theprmmaryrmresogarorsare o e oormer, Dr, Albert-Laszld Barabasi, Dr. Santiago all datasets that are available
Schnell, Dr. Alessandro Vespignani, Dr. Stanley Wasserman, and Dr, Eric &, Wernert, for algorithmic visualization

|| The NWE tool was developed by Weixia Huang, Russell Duhon, Micsh Linnemeier, Timothy Kelley, Duygu X or manipulation.
|Balcan, Marianao Beird, Bruce Herr, Santo Fortunato, Ben Markines, Felix Terkhorn, Heng Zhang, Megha

| Ramawat, César Hidalgo, Ramya Sabbineni, Yivek Thakres, Soma Sanval, Ann MoCranie, Alessandro
|Wespignani, and Katy Bérner, It uses the Cyberinfrastructure Shell (http:/ /cishell.org) developed at the
Cyberinfrastructure For Metwork Science Center (http://cns.slis.indiana.edu) at Indiana University,

Please cite as follows:
MWE Team. (2006). Metwork Warkbench Toal. Indiana University and Mortheastern University,
http:/ /nwb.slis.indiana.edu

i (E

— : Scheduler lists what aldorith R Table
cheduler lists what algorithms you've = )
| B scheduler used and displays algorithm @ Matrix
= Text

G GuEss

I Algorithm Marme Date Time % Complete !’g
Tree
[

o Network-

Console shows references to seminal works.
Workflows are recorded into a log file, and soon can be re-run for easy replication.
All algorithms are documented online; workflows are given in tutorials.
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File, Preprocessing, Modeling, and Visualization Menus

File Preprocessing Modeling Wisualization
Load... Extrack Top Modes Random Graph GLESS
Load and Clean ISI File Extract Modes Abave or Below Yalue Watts-Strogatz Small warld GruPlat
Read Directary Hierarchy Remove Mode Attributes Barabasi-lbert Scale-Free
Datasets Delete High Degree Nodes - DrlL (WxOrd)
Delete Random Modes Specified {prefuse beta)
Save. .. Chord
Delete Isolates X X
Hypergrid Circular {IUNG)
Wigw. ..
) ’ Extract Top Edges FRU )
Vigw with... Extract Edges Above or Below Yalue Rad!al i (Prefuse alpha)
TARL Radial Tree/Graph with Annotation {prefuse beta)
Merge Mode and Edge Files Remave Edge Attributes Y
i i Remove Self Loops Discrete Metwork Dynamics (DHD
Split Graph ta Mode and Edge Files s P! ] (DD Tra s forsfuse bsta)
Tests e Evolving Metwork (Weighted) Balloon Graph (prefuse alpha)
Snowball Sampling (n nodes
Preferences A — "nD 9 ) Farce Directed with Annotation (prefuse beta)
D. e Kamada-Kawai {JUNG)
Exit Edge Sampling

Fruchterman-Reingold {JUNG)

Fruchterman-Reingold with Annotation {prefuse beta)
Spring {JUNGE)

Small World {prefuse alpha)

Symmetrize
Dichotomize
Multipartite Joining
Iormalize Text
Slice Tiable by Time

Parallel Coordinates (demo)

Lahet

Circular Hierarchy

Borner, Katy, Sanyal, Soma and Vespignani, Alessandro (2007). Network Science. In Blaise Cronin (Ed.),
ARIST, Information Today, Inc./ American Society for Information Science and Technology, Medford, NJ,
Volume 41, Chapter 12, pp. 537-607.

http://ivlslis.indiana.edu/km/pub/2007-borner-arist.pdf )
- - - Jo]
Analysis Menu and Submenus
Analysis Unweighted and Undirected 3 | Unweighted and Directed »
Netwark Analysis Toalkt (NAT) Node Degree Node Indegree
Unweighted and Undirected Degree Distribution ll\irodie O'.tmr_e:.ﬁ
ee an

Weighted and Undirected ‘Watts-Strogatz Clustering Coefficient Outd:qee m;“wion

Unweighted and Directed ‘Watts Strogatz Clustering Coefficient over K

‘Weighted and Directed K-Mearest Neighbor

Diemoter Single Node In-Out Degree Correlations

Search Average Shortest Path

Discrete Network Dyniamics shortest Path Distribution PageRank

Textual Mode Betweenness Centrality HITS

Global Connected Components Dyad Reciprocity
Weighted and Undirected v HITS Bzl vday
Justering Coefficiant ) Adjacency Transitivity

Clustering Cosffici Weak Component Clustering

Nearest Neighbor Degres Blondel Community Detection Weak Component Clustering

Strength vs Degree Strong Component Clusteri

Degree & Strength MST-Pathfinder Network Scaling . v =

Average Weight v End-paint Degree ER— Blondel Community Detection

K-Mearest Neighbor (Java) Annotate K-Coreness Extract K-Core

Strength Distribution Annotate K-Coreness

Weight Distribution ‘weighted and Directed » |_

Randamize Weights HITS Search 4

MST-Pathfinder Network Scaling el Can

Fast Pathfinder Network Scaling Fast Pathfinder Network Scaling Eizi] : ;

K Random-¥Walk Discrete Network Dynamics 3

Blondel Community Detection Blondel Community Detection Randorn Breadth First Extract and Annotate Attractors
Borner, Katy, Sanyal, Soma and Vespignani, Alessandro (2007). Network Science. In Blaise Cronin (Ed.),
ARIST, Information Today, Inc./American Society for Information Science and Technology, Medford, NJ,
Volume 41, Chapter 12, pp. 537-607. http://ivl.slis.indiana.edu/km/pub/2007-borner-arist.pdf 26
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Gnuplot

portable command-line driven
interactive data and function plotting

utility http://www.gnuplot.info/.

GUESS
exploratory data analysis and visualization tool
for graphs and networks.

https://nwb.slis.indiana.edu/community/?n=Vi
sualizeData. GUESS.
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Supported Data Formats

The NWB tool supports loading the following input file formats:

GraphML (*.xml or *.graphml)
XGMML (*.xml)

NWB (*.nwb)
TreeML (*.xml)
Edge list (*.edge)
CSV (*.csv)

IST (*.isi)

Scopus (*.scopus)
NSF (*.nsf)
Bibtex (*.bib)

Endnote (*.enw)

VVVVYVYVVYYVYY

and the following network file output formats:

GraphML (*.xml or *.graphml)
Pajek .MAT (*.mat)

Pajek NET (*.net)

NWB (*.nwb)

XGMML (*.xml)

CSV (*.csv)

Formats are documented at https:

VVVYYVYY

Pajek .NET (*.net) & Pajek .Matrix (*.mat)

® edu.berkeley.guirprefusegraph.Tr

® sa‘data.T\EE/

® & text/tree mi+xml ® prefuse.data.Graph

filestextsegmml+xml

. filestext/isi

edu.berkeley.quirprefuse.graph.Graph
J

/.

file:text/bibtex

o eduuciicsjung graph.Graph ® file text/scopus

. file:text/referhib

. fileitext fosw

o filestext/graphml+xml

® filestext/ps

o

iwt.mageﬁuffeedlmage

® filetextfipg

.W.th/nwb

/

o file:application/pajeknet

o filestext/edge

@ file:application/pajekmat

nwb.slis.indiana.edu/community/?Pn=DataFormats.HomePage.
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Reading and Visualizing a Directory Hierarchy

Use File > Read Directory Hierarchy’ with parameters

I Read Directory Hierarchy

Roat directory I C:\Documents and Settings\katy\Desktophrwb

Levels to recurse | 1
¥ Recurse the entire tree

™ Read directories only (skips Files)

Canicel |

X

3
&
3

9

W

Visualize resulting ‘Directory Tree - Prefuse (Beta) Graph’ using

o Visunalization > Tree View (prefuse beta)’
o Visnalization > Tree Map (prefuse beta)’
o Visnalization > Balloon Graph (prefuse alpha)’

Visualization > Radial Tree/ Graph (prefuse alpha)’

29

Different views of the

/nwb directory

hierarchy.

Note the size of the
/plugin directory.

B BalloconTree

=100

rg.eclipse.asqi

(org.eclipse.update

’ METAINF
GUESS
Sontauraian i
plugins,
Notlizad I'It S pdatime_100 SETEINE
HIVE Fliles \ Fax_100
NotUsed Fajek HET File: \ aduuciicsjung_17 A METAINF
Notlsed AGMML Files org.cishell.enwirenment. equinox.feature
P ajek MAT Files)Sonrertsr tesd files (Featuras fuv it javaslgorithmfesture
ioilised TreeML Files sdu.iu b converter feature_1.0.0
e
GraphML Files, a1g oishell feature_100
TSV Files zamplzdata org sishell teference. gui feature
Configuration Files =duiunnk gui brand featurs_1.0.0
Edge Files arg oishell reference feature_1.0.0
Elolegy,
m-nn
el

METAINF
METAINF
= o [2ra)

FresHEP WectorGraphics 1.0.0
OSGHINE

plafusa lib_20060745.0.0

u V20070523
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Compute Basic Network Properties & View in GUESS

Select florentine.nwb in Data Manager.
> Run ‘Analysis > Network Analysis Toolkit (NAT)’ to get basic properties.

graph was not direc

» Optional: Run ‘Analysis > Unweighted & Undirected > Node
Betweenness Centrality’ with default parameters.

> Select network and run Visualization > GUESS’ to open GUESS with file loaded.
» Apply ‘Layout -> GEM’.

=10

=0

o« MWE fil2: C\Documents and SettingstkatyiD
gutEhss wasEsEtIE(t:j ¢ M pistribution of degree for network at st
ecatensoe ot Adar (BLESS), Russell Duhon rosizeinear, colrze ) £ %5 it of edes ofnetwark reated throush th
ntegrator(s): Russsll Duhon ¢ =¥ Distribution of degree For network at st
Reference: Adar, Eytan, "GUESS: A Language and Interface For Graph Exploration,” CHI 2006 (http://graphexploration.cond.org;) B Distribution of degree For nebwark at sty
Documentation: hittps:/ /nwh.slis.indiana.edu,'c ity ? i izeData.GUESS 2. NWB file: C\Documents and Settingstikatyil

FCHO is off.
tarting GUESS... raph and Network Analysis Log
FCHO is off. equence of site betweennesses For nod
The initial layout For your visualization is random. For a clearer visualization, please run a layout from the Layout menu. (W' recommend GEM. ) ! Distribution of site betweenness for nety
ECHO is off.
A 3 :
Y3UESS log File For this session can be Found in _,“ Distribution of site betweenness far nety
121\ DOCUME- Likaky\LOCALS~ 11 TemplCIShell-Session-55892) StaticExecutableRunner-55 904 ALGORITHM guesslog, txt +'5 " MWE file with site betweenness attribute
{=UESS was selected, Sis¥istolizet UL =l0lx|
uthor(s): Evean Adar Fle Edt Layout Script  View Help |
Implementer(s): Eykan Ad:
Integrator(s): Russell Dur?‘- Medici-Acciaiuoli (|
Reference: Adar, Eytan, g
Documentation: https://i| 8 Ficld | alue
ECHO Is off, § __edgeid (]
Btarting GUESS... = |business F
CHiovls cff, % color dandelion
The initial layout For vour v | 2
Diinta 5 drected false
\5UESS log File for this sess| 5 [label
-\ DOCUME~ Likaty\LOCA | abelcalor 0,0,0,255
labelsize 12
] scheduler | labelvisible falze
—_ marriage T
Remove From List | [ ¢ [nodet né
nodez ni
visible true
weight 1.0
I [ Agorittmn| MR 20
GUESS
GUESS
~|' Node Betw
[ Network. Ar
| Load...
¥ GruPlot
- ¥ Gruplat — =
i3 AR Ohbiject: | I'| Praoperty: : | Operator: | - | Walug:
¥| Degree Dis T e =
| Barabisi-a | Colour ‘ | Show ‘ ‘ Hide | ‘ Size | | Show Label | | Hide Label | ‘ Change Label
| GruPlat
¥ Degres Dis ‘ Hode Shape ‘ | Center | | change History |
v GUESS
Y Load...
| Interpreter , Graph Modifier |

| K2 | -+ 32




iBix] Pan:
File Edit Layout Script  Wiew Help “grab” the background
Medici ¢ by holding left-click
N ; .
§ | Field | vale J and moving your
é color cornflo...
< |fixed false mouse.
g fheioht 10,0 a
5 [image
E [label Medici /.oom:
— |labelcolor 0,0,0,... .
Isbelsize. |12 Using scroll wheel,
labelvi... fake €y «
ISR s ‘i‘a press th; +” and “-
original... Medici buttons in the upper-
D{‘“:':es 53d = Color... left hand corner, or
stroke... cadeth... . .
Remave h - h k d m
svle 2 right-click and move
. Add :
totalties S4 e Fild the mouse left or right.
visible  true O odify Field. ..
wealth 103 m Copy as Yariable, .. Cente.r graph by
widh 10,0 selecting “View ->
£ 90,625.., >
.y daiz e Centet’.
Av* Select %to
select/move single
Object: | |V| Property: |Iabelsize v| Operatar: Yalue: EI / &
nodes. Hold down
| Colour | | Shiow | | Hide | | Size | | Show Label | | Hide Label | | Change Label | ‘Shift’ to SClCCt
‘ Format Mode Labels | | Format Edge Labels | mU-hjple.
| Mode Shape | | Center | ‘ Change Histary |
| Resize Lingar | | Colorize | nght Cth to mOdlfy
Color, etc.
|N0des v| |Iabelsize v| From: | | Tt | | | Do Resize Linear
Interpreter . Graph Modifier )"
33
Graph Modifier:
Yisualization - GUESS 100 x|
[13 2 M
T T e mm G Eh | Select “all nodes” in the Object
Pucci | drop-down menu and click ‘Show
B ‘
g Fed | vake ‘,’ Label’ button.
E color 255,25..,
< [fixed False
E ‘“r:"agg:t 5.0 ‘ Castellani) Select ‘Resize Li > Nodes >
g . samagir) G0 e e(?t. ,eslze inear odes
~ |labelcalor 0,0,0,... —
bckc [0, Lo HESEN) poruzziy sanat) totalities’ drop-down menu, then
labeli... trus ‘i&l ALY type “5” and “20” into the From”
name niz
ariginal... Pucci _ P Pazzi) and To” Value box separately.
priorates O Bischeri) Ridolfi)
£ < M M ol
k... cadet.. | Meici) Then select ‘Do Resize Linear’.
shyle z
Tstiab\li:es E,UE . Tomabuoni) Acciaiuoli’)
¢ .
wealkth 3 Ly Select ‘Colorize>
dth 5.4 ..
e Nodes>totalities’, then select
G 1< Pusci) white and enter (204,0,51) in the
pop-up color boxes on in the
A “From” and “To” buttons.
Obijeck: | ‘V‘ Propetty: ‘Iabels\ze V| Operatar: Value: El
13 b
| Calour ‘ | Shaw | ‘ Hide: | | Size: | | Show Label | ‘ Hide Label ‘ | Change Label ‘ SeleCt Format NOde Labels >
|l Format Node Labels || | Format Edge Labels | replace default text {Orlglnallabel}
| Mode Shape | ‘ Cenker | ‘ Change History | Wlth your own label n the pop—up
¢ . .
box ‘Enter a formattmg string for
node labels.”
Inkerpreter . Graph Modifier }‘
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 -¥isualization - GUESS 10l x|
File Edit Layout Script  Wiew Help

Acciaiuoli:) |{

Field | Yalue J

color 255,24,

Fixed false
heoht s.6635...| | ) Castellani)

image

label Acciaiu. .. . Barbador) Ginori)
labelcolor 0,0,0,... Lamb ) peruzzi) saviat

labelsize 12
Alkizzi)

labelvi... true
Strozzi?) _
Bischeri?) Ridolfi:) Pazzi)
Medici:)

name ni
original... Acciaiuol
priorates 53

stroke... cadetb... Guadagni)
style z )
totalities 2 Tormabuoni) Acciaiuoliz)
visible  krue -0 ’
wealth 10 I‘k‘
width 5.6635...
% 11z2.01...
i s ?_Ej Pucci) Interpreter:
Uses Jython a combination of Java
& and Python.
w
=== resizelinear{totalities,5,20)
=== colorize{wealth,white,red) Try

=g
colorize(wealth, white, red)

resizeLinear(sitebetweenness, 5, 25)

i Interpreter /f' Graph MDdiFiEr}"
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oo Science of Science (Sci2) Tool
http://sci.slis.indiana.edu

1 & practice

» Explicitly designed for SoS research and practice, well documented, easy to use.

A\

Empowers many to run common studies while making it easy for exports to
perform novel research.

\4

Advanced algorithms, effective visualizations, and many (standard) workflows.

A\

Supports micro-level documentation and replication of studies.

» Is open source—anybody can review and extend the code, or use it for
commercial purposes.

SUMMARY

e Existing metrics have known flaws
e Areliable, open, joined-up data
infrastructure is needed
e Data should be collected on the full
O P | N | O N range of scientists’ work
e Social scientists and economists
should be involved

nature Vol 464|25 March 2010

Let's make science metrics more scientific

To capture the essence of good science, stakeholders must combine forces to create an open, sound and

consistent system for measuring all the activities that make up academic productivity, says Julia Lane. pe

ool fer

arch & practice

=i Sci® Tool = “Open Code for S&T Assessment”

Joint Co-Authorship Neswork

OSGi/CIShell powered tool with NWB plugins and

many new scientometrics and visualizations plugins.

O 0lakgy
[ ——
O 13 Bruin Research
10 Chensical, Mocharsical, & Civil Ergineering

Horizontal Time Graphs

Borner, Katy, Huang, Weixia (Bonnie), Linnemeier, Micah, Dubon, Russell |ackson, Phillips, Patrick, Ma, Nianli, Zoss,
Angela, Guo, F Immma & Price, Mark. (2009). Rete-Netzwerke-Red: Analyzing and 1 isualizing Scholarly Networks
Using the Scholarly Database and the Network Workbench Tool, Proceedings of ISST 2009: 1 21 International C onference
on Scientometrics and Informetrics, Rio de Janeiro, Brazil, July 14-17 . T ol 2, pp. 619-630.




Sci? Tool

\% Sci Tool
File Preprocessing Modeling  Analysis

Wisualization | Scientometrics  Help

& console.

‘ielcame to the Science of Science Toal (Sci
| The development of this tool is supported i

Metwork Science center and the School of Li
Indiana University, the Mational Science Fou
and I5-0715303, and the James S McDonnel
Cyberinfrastructure portal thttp:fscislis.ind

The primary investigators are Katy Bémer, In
SeiTech Strategies Inc, The Sci® tool was dew
). Duhon, Patrick & Phillips, Chintan Tank, a
Cyberinfrastructure Shell thitp:/fcishell.org
for Metwork Science Center (http:ficns.slis.i
Many algorithm plugins were derived from 4
thttp:finwb.slis.indiana.edu).

Flease cite as follows:
Sei® Tearn, (20093, Science of Science Toaol, T
Strategies Inc., http:fiscislis.indiana.edu.

=2 Scheduler|

Rernowve Fram List | [ Rermove completed

GLESS
GruPlot

Radial Tree/Graph (prefuse alpha)

Radial Tree/Graph with Annotation (prefuse beta)
Tree Yiew {prefuse beta)

Tree Map (prefuse heta)

Force Directed with Annotation (prefuse beta)

Fruchterran-Reingold with Annotation (prefuse beta)

DL QxOrd)
Specified (prefuse beta)

Horizontal Line Graph

Circular Hierarchy

Geo Map (circle annotations)

Geo Map (region coloring annotations)

Image Wiewer

Load and Clean ISI File

09/03/2009

Reftdapper
! Algorithm Mame Date Tirme % Corr
[ Extract Co-Zuthor Metw..,  09/037/2009 00:15:20 A0 | —

0015054 —

<

Sci? Tool: Algorithms

See bttps:/ [ nwb.slis.indiana.edn/ community

Preprocessing Modeling Weighted & Undirected
Extract Top N% Records Random Graph Clustering Coefficient
Extract Top N Records Watts-Strogatz Nearest Neighbor Degree
Normalize Text Small World Strength vs Degree
Slice Table by Line Barabasi-Albert Scale-Free Degree & Strength

TARL Average Weight vs End-point Degree
Extract Top Nodes Strength Distribution
Extract Nodes Above or Below Value  Analysis Weight Distribution
Delete Isolates Network Analysis Toolkit (NAT) Randomize Weights

Extract top Edges

Extract Edges Above or Below Value
Remove Self Loops

Trim by Degree

MST-Pathfinder Network Scaling
Fast Pathfinder Network Scaling

Snowball Sampling (in nodes)
Node Sampling
Edge Sampling

Symmetrize
Dichotomize
Multipattite Joining

Geocoder

Extract ZIP Code

Unweighted & Undirected
Node Degtee
Degree Distribution

K-Nearest Neighbor (Java)
Watts-Strogatz Clustering Coefficient
Watts Strogatz Clustering Coefficient over K

Diameter

Average Shortest Path
Shortest Path Distribution
Node Betweenness Centrality

Weak Component Clustering
Global Connected Components

Extract K-Core
Annotate K-Coreness

HITS

Blondel Community Detection

HITS

Unweighted & Directed

Node Indegtee

Node Outdegree
Indegree Distribution
Outdegree Distribution

K-Nearest Neighbor
Single Node in-Out Degree Correlations

Dyad Reciprocity
Arc Reciprocity
Adjacency Transitivity

Weak Component Clustering
Strong Component Clustering
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Sci? Tool: Algorithms cont.
See bttps:/ [ nwb.slis.indiana.edn/ community

Visualization Scientometrics
Extract K-Core GnuPlot Remove ISI Duplicate Records
A GUESS Remove Rows with Multitudinous Fields
nnotate K-Coreness . :
Image Viewer Detect Duplicate Nodes
Update Network by Merging Nodes
HITS Radial Tree/Graph (prefuse alpha)
PageRank Radial Tree/Graph with Annotation Extract Directed Network
Weighted & Directed (prefuse beta) Extract Paper Citation Network
HITS Tree View (prefuse beta) Extract Author Paper Network
. Tree Map (prefuse beta)
Weighted PageRank Force Directed with Annotation Extract Co-Occurrence Network
(prefuse beta) Extract Word Co-Occurrence Network
Textual Fruchterman-Reingold with Annotation Extract Co-Author Network
Burst Detection (prefuse beta) Extract Reference Co-Occurtrence
(Bibliographic Coupling) Network
DrL. (VxOrd)
Specified (prefuse beta) Extract Document Co-Citation Network

Horizontal Line Graph

Circular Hierarchy

Geo Map (Circle Annotation Style)

Geo Map (Colored-Region Annotation Style)
*Science Map (Circle Annotation)

NEW: * Requires permission from UCSD
Database support for ISI and All four+ save into Postscript files.
NSF data. Automatic legends.
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S 8¥sel  Sci2 Tool: Download, Install, and Run

B b ] b 31 caers e

Sci? Tool Alpha 3 (March 2010)

Can be freely downloaded for all major Z‘j’*"w— o e
operating systems from
http://sci.slis.indiana.edu/sci2

“Sci? Tool

Select your operating system from the pull
down menu and download.

Unpack into a /sci2 directory. rrr——
Run /sci2/sci2.exe S e

Windows (4F. Vista & T) = i.-. ;; oH -.-i

Sci’ Teal Alpha 1
Dicormbar 1168, 3008

Windows (G Vista & T) i W ...._.i

Session log files are stored in
“Syournwbdirectory*/ logs’ directory.

Cite as . r‘w
Se# Team. (2009). Science of Science (Sci) Tool. The file was also made available as
Indiana University and SciTech Strategies, 5c2-N-1.0.0.201003270106 NG T-
bttp:/ [ sei.slis.indiana.edu win32.win32.x86.3ip

on the computers in the tutorial room.
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Forgot your password?

To recover your account password, please visit our password recovery page

Not registered yet?

Register now

Tutorials

Scott Weingart, Hanning Guo, Katy Bomer, Kevin W. Boyack, Micah W. Linnemeier, Russell J. Duhon, Patrick A. Phillips, Chintan Tank, and Joseph
Biberstine (2010) Science of Science (Scil) Tool User Manual. Cyberinfrastructure for Network Science Center, School of Library and Information
Science, Indisna University, Bloomington.

Katy Borner and Angela Zoss (2010) Plug-and-Play Macroscopes Tutorial. International Conference on Secial Computing, Behavioral Modeling and
Prediction, Bethesda MD.

In the news

The Trustees of Indiana University. SLIS researcher promotes Innovation Dashboard for pelicvmakers during Capitel Hill visit. (website accessed

Please cite as

Sei’ Team (2009). Science of Science (Sei’) Tool Indiana University and SeiTech Strategies, hutp-/sei slis ind
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)%?3 CIShell

CIShell — Add new Plugins, e.g., UCSD Science Map

» Not all code can be shared freely (yet).
» 'To make the UCSD Science Map and new geomaps available via the Sci? menu,

simply add
wrnerkiDeskkopiNIH-12sciz-plugins v | 0 Tb@ﬁ/&f were mdde
Mame Size | Type Date Modified ﬂpﬂz'/dble Z?’Z
edu.iu. scipalicy . visualization. geomaps_0.0.1 .jar 4,864 KB Executable Jar File 6/24/2010 5:41 PM
edu.iu.scipolicy, visualization, scimaps_0.0.1. jar 1,507 KB Executable Jar File 6/18/20103:17 PM 1D ; ,
org.cishell.reference. gui.persistence_1.0.0.jar 61 KB Executable lar File 6/24/2010 5:41 PM /§[Z2 p/ﬁ/glﬂ.f dZVeﬂ‘OO/
org.cishell utilities_1.0.0.jar 7Z2KB Executable Jar File 6/24/20105:41 PM on l‘/9€ [0777pﬂl‘6’71§‘ Z;’Z [be
to the ‘yourdirectory/ plugin’ directory and restart the tool. tutorial room.

The rights to the UCSD map are owned by the Regents of UCSD. Usage does not require

a separate, signed agreement or an additional request to our office if consistent with the

permission. As a courtesy, please send information on how the map is being used to
William J. Decker, Ph.D., Associate Director, Technology Transfer Office

University of California, San Diego, 9500 Gilman Drive Dept. 0910, La Jolla, CA 92093
phone:858-822-5128, fax: 858-534-7345, e-mail: widecker@ucsd.edu

» To delete algorithms that you do not use, simply delete the corresponding *.jar files in
the plugin directory.

» Customize your menu structure accordingly—see next slide.

"333 C I 51| CIShell - Add new Plugins, e.g., UCSD Science Map

»  After you added the new plugins, load an ISI file using ‘File > Load and Clean ISI File
> BugeneGarfield.isi.

The file can be found in the /sampledata/ scientometrics/ isi directory.

> Select ‘99 Unique ISI Records’ file in Data Manger and run “Visualization > Topical >
Science Map via Journals’ with parameters:

M Science Map via Journals @

Locate the journals from a table on the UCSD Map of Science

Journal column [Journal Mame (Abbi d)
Scaling Factor ‘ 1.0 |
Dataset display name ‘ EugeneGarfield. isi |

» The result is a science map ‘

overlay of Garfield’s papers o0 8% ddig 2
and a listing of journals in . ’ N
13 fields of science below. | o eg:‘;
See details in Tutorial #6. | .. . 7 g

o ==
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JO\ -
gg_gc I ne CIShell — Customize Menu

> 'The file Yourtooldirectory/ configuration/ defanlt_menn.xml’ encodes the structure of
the menu system.

» In NWB Tool, the Modeling menu (left) is encoded by the following piece of

xml code:

&8 Metwork Workbench Tool

File Preprocessing [Modeling | &nalysis Visualization Scientometrics

B Console Randam Graph
I NE METWOrK WOrKDe Watts- Strogatz Small World o
irvestigatars are Dr, K chi

\fasserrman, and Dr, £ Barabasi-2lbert Scale-Free

The NWE toal was de  ©*" !
Tank, Joseph Bibersti  Chard cd
Terkhorm Heng Zhan, en

Vespignani, and Katy Hyperarid

PRU
Metwark Warkbench ) d
Science Center thttp: TARL

<top_menu name="Modeling">
mx$mag%$ﬁ Diserete Network Dynamics (0 <menu pid="edu.iu.nwh.modeling. erdosrandomgraph” />
mmﬁézaﬂhmﬁm Evnlving Network (Weighted) <menu pid="edu.ju.nwh.madeling. smallworld" />
——————— <menu pid="edu.iu. nwh.modeling. barabasialbert" >
<menu type="hreak" />
<menu pid="edu.ju. jv.modeling. p2p. can.Canalgorithm" />
<menu pid="edu. ju. iv.modeling.pZp. chord.chordalgorithm” >
<menu pid="edu.id.v.modeling. p2p. hypergrid. Hypergrid" >
<menu pid="edu.fu. iv.modeling. p2p. pru. Prualgorithm” S
<menu type="hreak" />
<menu pid="edu.ju, Jv.modeling. tarl.Tarlalgorithm" />
<menu type=“break“/>
<menu pid="edu.ju. nwh.modeling. discretenetworkdynamics. onoalgorithm” />
<menu type="hreak"/>
<menu pid="edu.ju. nwh.modeling. weighted. evolvingnetwork" />
</top_menu>
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JO\ .
gg_g(: I Nne CIShell — Integrate New Algorithms

Algorithm Developer's Guide

Overview

The Cyberinfrastructure Shell (CIShell) is an open source, community-driven platform
for the integration and utilization of datasets, algorithms, tools, and computing
resources. algarithm integration support is built in for Java and most other programming
languages. Being Java based, it will run on almost all platforms. The software and
specification is released under an Apache 2.0 License,

This guide attempts to aid algorithm developers in creating algorithms for CIShell {and
applications built on CIShell).

This guide tries to contain all the information a new developer needs, but where
necessary, it may cite the CIShell 1.0 Specification (API) or the DSGi Service Platform
Specification, Release 4 (API}. While the guide tries to make beginning algorithm
development easier, the CIShell Specification has the last word on how the CIShell
Platfarm works.,

Table of Contents

1. CIShell Basics

2. Getting Started

. Tutorial 0: Setting Up the Development Environmeant

. Tutorial 1: Creating a Hello World Java algorithm

. Tutorial 2: Practical Java Algorithrm Development

. Tutorial 3: Integrating a Mon-lava Prograrm As An Algorithrn

. Mini-Tutorial: Integrating 3rd-party libraries

. Where to Learn More

3. Reference
1. How Algorithrms Work: & guide to algorithim plugins in C1Shell
2. Accessing the OSGi Console in CIShell tools

[y B SO T L

http:/ [ cishell.ore/ 2n=DevGuide. NewGuide
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Promising Research Directions

J.-.m%&_
Iﬁlb
. : j OSGi/CIShell Adoption

T P

q

: ‘;"ﬂ'fﬂq(t AW

CIShell/OSGi is at the core of different CIs and a total of 169 unique plugins are used in the
- Information Visualization (http://iv.slis.indiana.edu),

- Network Science (NWB Tool) (http://nwb.slis.indiana.cdu),

- Scientometrics and Science Policy (Sc¥ Tool) (http://scislis.indiana.edu), and

- Epidemics (http://epic.slis.indiana.cdu) research communities.

Most interestingly, a number of other projects recently adopted OSGi and one adopted CIShell:

Cytoscape (http:/ /www.cytoscape.org) lead by Trey Ideker, UCSD is an open soutce bioinformatics
software platform for visualizing molecular interaction networks and integrating these interactions
with gene expression profiles and other state data (Shannon et al., 2002).

Taverna Workbench (http://taverna.sourceforge.net) lead by Carol Goble, University of Manchester,
UK is a free software tool for designing and executing workflows (Hull et al., 2000). Taverna allows
users to integrate many different software tools, including over 30,000 web services.

MAEVviz (https:/ /wiki.ncsa.uiuc.edu/display/MAE/Home) managed by Shawn Hampton, NCSA is an

open-source, extensible software platform which supports seismic risk assessment based on the Mid-
America Earthquake (MAE) Center research.

TEXTrend (http:/ /www.textrend.org) lead by George Kampis, E6tvés University, Hungary develops a
framework for the easy and flexible integration, configuration, and extension of plugin-based
components in support of natural language processing (NLP), classification/mining, and graph

algorithms for the analysis of business and governmental text corpuses with an inherently temporal
component.

As the functionality of OSGi-based software frameworks improves and the number and diversity of
dataset and algorithm plugins increases, the capabilities of custom tools will expand.




The Changing Scientific Landscape

Star Scientist -> Research Teams might have 100 or more members & exist few months only.
Users -> Contributors students, faculty, practitioners.
Disciplinary -> Cross-disciplinary with different cultures, languages, approaches.
One Specimen -> Data Streams updated nightly or even more frequently

High Quality Open Data

@ Scholarly Database: 23 million scholatly records

http://sdb.slis.indiana.edu
géfé‘}% VIVO National Researcher Networking
Gt Dttp://vivoweb.org

Static Instrument -> Evolving Cyberinfrastructure (CI) daily learning and documentation.

Macroscopes can make a major difference if they support:

Division of Labor — proper incentive structures are key.

Ease of Use — learn from YouTube, Flickr, Wikipedia

Modularity — plug-and-play helps reduce costs; increases flexibility, augmentation, customization
Standardization — speeds up ‘translation’ into products/practice.

Open Data and Open Code — use the minds of millions!

Epidemics Marketplace

: : 7 ; ¥ My Account
i Browse @ Upload = Request | About

piC

w . Recent Activity
The EpiC Marketplace [l
— P P it
Aco o a. Lear > coverage data. - Micah
Demographics Iinnemeder- Indiana
Infectious Diseases ke
havedam an haakhinurnce
e e r—— ®@Browse (@®Upload (?Request [
Transportation View & Download  Upload your Can't find a dataset i
Uncategorized projects, datasets, datasets or create you're looking for?
) ) HIV/AIDS - Him Sherman
and requests, by a project with Make a Request! s e
125§ 1918 § a8 § Adeiewmm § category and tags multiple datasets I
w2 § mrioe § Bcbomer § bedily § Data Upload:
mondn § ole § doobom § Location of datasets AiSictnte

Derzgrophie.. § demegrophe.. § llmlsi'ngval:an.zigsand

lomahe § famly § Migh § ﬂu§
Muida § Frun oo

[ i [ setelin= | rbric |

L
¢

i HIVE Hmm; 4

Heumog Vae.. § iTC0TRE £

¥RFSS: Turning Tnfarmacin inwa
Heakh The Eehaviora| Risk Faccar
< Symem (ERFS s rhe

bttp:/ [ dev.epic.slis.indiana.edn
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cyberinfrastructure for
ETVWORK SCIENCE CENTER

School of Library and Information Science | Indiana University Bloomington

Cyberinfrastructures Qutreach

All papers, maps, cyberinfrastructures, talks, press are linked
from http://cns.slis.indiana.edu
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